
PKZIP® for Windows Help
Welcome to PKZIP for Windows!    You have selected the premier data compression program available to 
compress and extract files.    The world's most popular data compression program combines with the most
widely-used interface to give you superior data compression that's easy to use.

Click on the PKZIP for Windows Help topic of your choice:

Compressing    Files                                  Create new .ZIP files, add files to an existing .ZIP file, 
and delete files from a .ZIP file.

Uncompressing Files                    Extract files from a .ZIP file, and test the integrity of    
those files.

Viewing Files Within a .Zip File View files contained in a .ZIP file from the PKZIP main 
application window.

Setting Options and Preferences Set options to view and sort files, cascade and tile file 
windows, and set preferences for compressing, 
extracting, and viewing.

Using the PKSFX Self-Extractor Create self-extracting .ZIP files that allow someone to 
extract files without even having PKZIP for Windows 
installed on their computer.

Converting .EXE and .ZIP Files Convert a .ZIP file to a .EXE file (self-extractor), or one 
type of self-extractor to another.

Moving and Copying Files and 
Archives

Move and Copy Archives from within the main 
application window. Move and copy files from one .ZIP 
file to another.

Using the Windows Explorer with 
PKZIP for Windows

Use the Windows Explorer to create, open, extract, and
test .ZIP files.

File Format Support Encoded and Archived file (e.g. UUEncoded, TAR) 
support in PKZIP for Windows.
 

License Information        Display license information.

Associating the .ZIP Extension with 
PKZIP for Windows

Register the .ZIP filename extension with PKZIP for 
Windows.

Uninstalling PKZIP for Windows Remove PKZIP for Windows from your system.

For Help on Help, Press F1



Compressing Files

Creating a New .ZIP File                Learn how to create a new .ZIP    file.

Creating a New Spanned .ZIP File Learn how to create a .ZIP file that 
spans across multiple diskettes 
or other media.

Adding Files To a .ZIP File          Learn how to add files to an existing .ZIP file.

Adding Files With a List File Learn how to add files using a List file.

Deleting Files From an Existing .ZIP File     Learn how to delete files from an existing .ZIP file.

Viewing a .ZIP File Comment Learn how to view a comment that was included 
with a .ZIP file. 

Viewing .ZIP File Statistics Learn how to view .ZIP file statistics, for example, 
the number of files in a .ZIP file, and the 
compressed and uncompressed size of each file.

Creating .ZIP Files With the PKZIP Wizard Learn how to use the PKZIP wizard to create .ZIP 
archives.



Uncompressing Files

Extracting Files From    a .ZIP File      Learn how to extract files from a .ZIP file.

Extracting Files From a Windows Self-Extractor Learn how to extract files from a self-extracting 
(.EXE) file.

Extracting Files From a DOS Self-Extractor Learn how to extract from a DOS self-
extracting (.EXE) file.

Extracting Files From a Spanned .ZIP or .EXE 
File

Learn to extract files from a “spanned” .ZIP 
or .EXE file (a file than spans across more than
one diskette or other media).

Testing .ZIP File Integrity              Learn how to test the integrity of the files 
contained in a .ZIP file.

Extracting Files Using the PKZIP Wizard Learn how to use the PKZIP wizard to 
uncompress files contained in .ZIP archives.



Setting Options and Preferences

Setting View Options:

PKZIP Viewing Options Erase gridlines, zoom in and out, and set the font.
 

Sorting Files Within a .ZIP File Sort the files within a .ZIP file by filename, extension, 
size or date.

Cascade And Tile .ZIP Files Cascade and Tile .ZIP file windows you have opened.

Setting PKZIP for Windows Preferences:

Compressing                            Set preferences for compressing files.

Extracting            Set preferences for extracting files.

Viewing Files Set preferences for viewing files.



Using the PKSFX Self-Extractor

What is a Self-Extracting File? Learn about what a self-extracting file is.

Creating a Self-Extracting File Create a self-extracting file.

Setting PKSFX Options Set options for a self-extracting file.

Converting .EXE and .ZIP Files Convert .EXE and .ZIP files.

Creating Self Extractors With the pksfxs.dat 
File

Self extractors available in the Distribution 
Licensed version of PKZIP for Windows.



License Information

PKZIP ® for Windows      Version 2.60            12-15-97
Copyright 1989-1997 PKWARE Inc. All Rights Reserved
PKZIP Reg. U.S. Pat. and Tm Off.    Patent No. 5,051,745

PKWARE DISCLAIMS ALL WARRANTIES AS TO THIS SOFTWARE, WHETHER EXPRESS OR 
IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, FUNCTIONALITY OR DATA INTEGRITY OR PROTECTION.

See documentation for further disclaimers and information.

For use on multiple machines or to use to distribute your information or software, a separate license is 
required.    Please see the LICENSE.TXT file for further information.



What Type of Self-Extracting File?

Creating a Regular DOS Self-Extractor

Creating a Junior DOS Self-Extractor

Creating a Windows Self-Extractor

Creating a Self Extractor with the pksfxs.dat file



Extracting From a Self-Extracting (.EXE) File

Extracting From a Windows Self-Extractor

Extracting From a Regular (DOS) Self-Extractor



Extracting From a Spanned File

Extracting From a Spanned .ZIP File

Extracting From a Spanned .EXE (self-extractor) File 
 



Creating a New .ZIP File
You can create new .ZIP files in the following ways:

· Using the Windows drag and drop feature.

· Using the Windows Explorer.

· Selecting File from the PKZIP for Windows Menu bar and New from the File menu.

· Using the Tool bar button.



Drag and Drop
PKZIP for Windows allows you to create .ZIP files by “dragging and dropping” files using the Windows 
File Manager or Windows Explorer.    This method gives you a quick and easy way to compress files.    
When you use this method, you can't set Compress preferences because PKZIP for Windows 
compresses the file immediately, and uses the current settings for these preferences.

To create a new .ZIP file using drag and drop:

1. Start PKZIP for Windows by double-clicking on the icon. The PKZIP for Windows main application 
window appears.

2. Using the File Manager or Explorer, locate the file(s) you want to compress in the new .ZIP file and 
drag it on top of an empty section of the PKZIP main application window. (If you drop it on top of an 
open .ZIP file, the file will be compressed into “that” .ZIP file.) The Save as dialog box appears. 

3. Type a name for your new .ZIP file and click Save/OK. 

If you are creating a regular (non self-extracting) .ZIP file, PKZIP for Windows begins to compress the
files and a box appears that displays the contents of the .ZIP file.

If you are creating a self-extractor, the PKSFX for Windows - Options dialog box appears. Set options 
for the self-extractor, if necessary. When you click OK in that dialog box, PKZIP for Windows begins 
to compress the files and a box appears (the .ZIP File Display Window) that displays the contents of 
the .ZIP file.

To add files to an existing .ZIP file using drag and drop:

1. Start PKZIP for Windows by double-clicking on the icon. The PKZIP for Windows main application 
window appears.

2. Open the existing .ZIP archive.

3. Using the File Manager or Explorer, locate the file(s) you want to compress in the existing .ZIP file 
and drag it on top of that .ZIP file window located in the PKZIP for Windows main application window.

4. PKZIP for Windows begins to compress the files and the .ZIP file window will subsequently display 
the updated contents of the .ZIP file.      

Note:      You cannot drag and drop files into opened encoded (e.g. *.UUE, *.XXE, *.MIM, *.MME, *.HQX) 
and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



The PKZIP Menu Bar
Creating a .ZIP file using the PKZIP for Windows Menu bar gives you more control in compressing and 
extracting files. Use this method if you want to take full advantage of PKZIP for Windows’ features.

To create a new .ZIP file from the menu:

1. Start PKZIP for Windows by double-clicking on the icon. The PKZIP for Windows main application 
screen appears.

2. From the Menu bar, select File. The File menu appears. Select New. The Save As dialog box 
appears.

3. Type a    name for your new .ZIP file and click OK/Save. The Add Files dialog box appears.

4. Select the files you want to compress. The different methods of selecting files appear below:

To add individual files, select the file(s) from the Windows file list and click on Add Files.

To add all files in a directory, select the directory and click on Add Directory.

To add files that match a file pattern, type a pattern (for example, *.TXT) in the Filter box, then click on
Add Filter. PKZIP for Windows displays the selected files in the Files & Directories to Zip box.

To add files that have been previously specified in a List File, select the list file from the Windows file 
list and click Add List File.

To manually add files or file patterns, click on Manual add. The Manual Add dialog box appears.    
Type a filename or file pattern (using DOS rules) and click on OK. 

To exclude files that match a specified file pattern, type a pattern (for example, *.TXT) in the Filter 
box, then click on Exclude filter. PKZIP for Windows displays the excluded file pattern preceded by 
the “Exclude =“ in the Files & Directories to Zip box.

Before you start the compression, you can edit the files or file patterns you have selected. To remove 
individual files from the list, select the file(s) then click Remove. To remove every file in the list, click 
on Remove all. To exclude/include files in the list, select the file(s), then click on Toggle 
Include/Exclude. To toggle back, click on Toggle Include/Exclude again.

5. Set    Compress preferences , if needed, by clicking on the Preferences button.

6. To assign a password to the .ZIP file, click on Password. PKZIP for Windows will prompt you for a 
password when you click on OK to start compressing.

To delete the original files from your hard disk after they have been compressed and put into the .ZIP 
file, click on Move files.

To include a comment with the ZIP file, click on ZIP Comment. 

7. When you have finished selecting the files to compress, click on OK.

If you clicked on Password in the Add File dialog box, the Password dialog box appears. Enter a 
password. 



If you clicked on ZIP Comment in the Add Files dialog box, the .Zip Comment dialog box appears. 
Enter a comment.

If you are adding files to a Windows self-extracting file, the PKZIP for Windows - Options dialog box 
appears. Set options, if needed.

PKZIP for Windows begins to compress your files and the Add Status dialog box appears.

The first line displays the percentage completed for the entire .ZIP file.    The second line displays the 
percent completed for the current file that is being compressed.    The lower area shows how each file 
was compressed and the overall percentage that it was compressed.

8. After all the files are compressed, select the Done button to remove the Add Status dialog box.    
PKZIP for Windows opens the .ZIP file and displays the contents of the file (in the .ZIP File Display 
Window).



Using the Tool Bar Button
To create a new .ZIP file using the Tool bar button:

1. Click on the  button. The Save as dialog box appears.

2. Type a    name for your new .ZIP file and click Save/OK. The Add Files dialog box appears.

3. Select the files you want to compress. The different methods of selecting files appear below:

To add individual files, select the file(s) from the Windows file list and click on Add Files.

To add all files in a directory, select the directory and click on Add Directory.

To add files that match a file pattern, type a pattern (for example, *.TXT) in the Filter box, then click on
Add Filter. PKZIP for Windows displays the selected files in the Files & Directories to Zip box.

To add files that have been previously specified in a List File, select the list file from the Windows file 
list and click Add List File.

To manually add files or file patterns, click on Manual add. The Manual Add dialog box appears.    
Type a filename or file pattern (using DOS rules) and click on OK. 

To exclude files that match a specified file pattern, type a pattern (for example, *.TXT) in the Filter 
box, then click on Exclude filter. PKZIP for Windows displays the excluded file pattern preceded by 
the “Exclude =“ in the Files & Directories to Zip box.

Before you start the compression, you can edit the files or file patterns you have selected. To remove 
individual files from the list, select the file(s) then click Remove. To remove every file in the list, click 
on Remove all. To exclude/include files in the list, select the file(s), then click on Toggle 
Include/Exclude. To toggle back, click on Toggle Include/Exclude again.

4. Set    Compress preferences , if needed, by clicking on the Preferences button.

5. To assign a password to the .ZIP file, click on Password. PKZIP for Windows will prompt you for a 
password when you click on OK to start compressing.

To delete the original files from your hard disk after they have been compressed and put into the .ZIP 
file, click on Move files.

To include a comment with the ZIP file, click on ZIP Comment. 

6. When you have finished selecting the files to compress, click on OK.

If you clicked on Password in the Add File dialog box, the Password dialog box appears. Enter a 
password. 

If you clicked on ZIP Comment in the Add Files dialog box, the .Zip Comment dialog box appears. 
Enter a comment.

If you are adding files to a Windows self-extracting file, the PKZIP for Windows - Options dialog box 
appears. Set options, if needed.

PKZIP for Windows begins to compress your files and the Add Status dialog box appears.



The first line displays the percentage completed for the entire .ZIP file.    The second line displays the 
percent completed for the current file that is being compressed.    The lower area shows how each file 
was compressed and the overall percentage that it was compressed.

7. After all the files are compressed, select the Done button to remove the Add Status dialog box.    
PKZIP for Windows opens the .ZIP file and displays the contents of the file.



Adding Files to a .ZIP File
With PKZIP for Windows, you can add files to an existing .ZIP file. You can:

· Add files (add files regardless of what is currently in the .ZIP file).

· Update existing files (update files within a .ZIP file with newer versions of those files).

· Add “and” update files (add and update files).

To add files:

1. Open the .ZIP file you want to add files to. PKZIP for Windows displays the contents of the .ZIP file.

2. From the Menu bar, select Compress. The Compress menu appears.

3. Select Add files. The Add Files dialog box appears.

4. Select the method of adding files. These methods appear in the Add Options area of the dialog box. 

To add files to your .ZIP file, regardless of what is currently in the .ZIP file, click on Add files.

To only update existing files within the .ZIP file, click on Update files.

To add new and update existing files, click on Add & Update Files.

To assign a password, click on Password. PKZIP for Windows will prompt you for a password when 
you click OK to start compressing.

To delete original files (from the disk drive) after they are compressed, click on Move files. 

To include a comment with the .ZIP file, click on ZIP Comment.

5. Select files to .ZIP.    You can select files in the following ways:

To add individual files, select the file(s) from the Windows file list and click on Add Files.

To add all files in a directory, select the directory and click on Add Directory.

To add files that match a file pattern, type a pattern (for example, *.TXT) in the Filter box, then click on
Add Filter. PKZIP for Windows displays the selected files in the Files & Directories to Zip box.

To add files or file patterns stored in a List File, select the List file and click on Add List File. Any files 
or file patterns specified in the List File will be displayed in the Files & Directories to Zip box.

To exclude files that match a specified file pattern, type a pattern (for example, *.TXT) in the Filter 
box, then click on Exclude Filter. PKZIP for Windows displays the excluded file pattern preceded by 
the “Exclude =“ in the Files &    Directories to Zip box.

To manually include or exclude files or file patterns, click on Manual Add. The Manual Add dialog box
appears.    Type a filename or file pattern (using DOS rules) and click on OK. 

To remove files from the list, select the file(s) then click Remove. To remove every file in the list, click 
on Remove all. To exclude or include files in the list, select the file(s), then click on Toggle 



Include/Exclude. To toggle back, click on Toggle Include/Exclude again.

6. Set Compress preferences , if needed, by clicking on the Preferences button.

7. When you have finished selecting files to compress, click on OK. 

If you clicked on Password in the Add File dialog box, the Password dialog box appears. Enter a 
password. 

If you clicked on ZIP Comment in the Add Files dialog box, the .Zip Comment dialog box appears. 
Enter a comment.

If you are adding files to a Windows self-extracting file, the PKZIP for Windows - Options dialog box 
appears. Set options, if needed.

PKZIP for Windows begins to compress your files and the Add Status dialog box appears. 

The first line displays the percentage completed on the entire .ZIP file.    The second line displays the 
percent completed for the current file that is being compressed.    The lower area shows how each file was
compressed and the overall percentage that it was compressed.

After all the files are compressed, click on the Done button to remove the Add Status box.    PKZIP for 
Windows opens the .ZIP file and displays the contents of the file.



Entering a Password
To enter a password:

1. Verify that you have checked the Password box in the Add Files dialog before clicking OK.

2. The Password dialog appears. In the Enter Password field, type your password.

3. When you have finished, click OK. PKZIP for Windows assigns the password to your .ZIP file. 



Entering a .ZIP Comment
To enter a comment:

1. Verify that you have checked the .ZIP Comment box in the Add Files dialog before clicking OK.

2. The .ZIP Comment dialog appears. Type your comment in the area provided. 

3. When you have finished, click on OK. PKZIP for Windows inserts the comment into your .ZIP file.



Deleting Files From an Existing .ZIP File
To delete files:

1.    Open the .ZIP file you want to delete from. PKZIP for Windows displays the contents of the .ZIP file.

2.    Select the files you want to delete.    

3.    From the Menu bar, select Compress. The Compress menu appears. 

4.    Select Delete files from the Compress menu. The Delete Files dialog box appears.

5.    To delete the files, click on Yes. PKZIP for Windows deletes the files and the Delete dialog box 
closes.

To cancel without deleting the files, click on No. No files are deleted.



Creating a New Spanned .ZIP File
Note:      If you are creating a spanned .ZIP archive on Windows 95 or Windows NT that will be 
subsequently opened on a Windows 3.x PC, it is recommended that you perform a Quick Format on the 
diskettes before spanning .ZIP files onto them. Additionally make sure that you select a name for the .ZIP 
file using standard DOS 8+3 (eight characters or less with a three-character extension) naming 
conventions. Refer to your Microsoft Windows on-line help or User's Manual for more information on 
formatting diskettes or naming conventions.

PKZIP for Windows allows you to compress files onto diskettes or other media. When you create that .ZIP
(or .EXE) file, you might have so many files or so many large files that, even compressed, might take up 
more space that is available on your diskette or other medium. With PKZIP for Windows, you can “span” a
.ZIP or Windows self-extractor across multiple media. 

You can only create spanned files for Windows 16-bit or 32-bit self-extractors, not for DOS self-extractors.

One of the limitations of a spanned .ZIP file is that you cannot modify it. For example, you cannot add files
to a spanned .ZIP file or move files from a spanned .ZIP file to another .ZIP file. 

To create a spanned file:

1. Insert a diskette into your disk drive. 

2. Create the .ZIP or .EXE as you normally would using PKZIP for Windows.

As PKZIP for Windows compresses, when the first diskette is full, a message box that contains the 
following message appears:

Insert Disk #2

3. Insert the next diskette and click OK. PKZIP for Windows continues to compress files.

4. If PKZIP for Windows has finished compressing files, the word Done appears in the Add Status box. 
Click on Done to end this session.

If the current diskette is full, an Insert Disk #3 message appears. Repeat steps 2 through 4 until you 
get the Done message.



Converting .EXE and .ZIP Files
PKZIP for Windows allows you to convert .EXE and .ZIP files. You can convert a .EXE file to a .ZIP file, 
a .ZIP file to a .EXE file, and even one type of .EXE file to another (for example, a regular DOS self-
extractor to a Windows 16-bit self-extractor).

Since you cannot modify a spanned .ZIP file, you cannot convert a spanned .ZIP file. 

To convert files:

1. Within PKZIP for Windows, open the .EXE or .ZIP file that you want to convert. PKZIP for Windows 
displays the contents of that file. 

2. From the File menu, select Convert. The Save As dialog box appears.

3. In the Save As dialog box, do the following:

In the File name text box, type the name of the new file. If you are converting one type of .EXE to 
another, you must give this a new file name.

In the Save as type text box, select the type of file you want to convert the original file to.

4. When you have finished with this dialog box, click OK. The contents of the new file appear in a 
window on top of the original file.



Moving and Copying Files and Archives
PKZIP for Windows allows you to copy, delete, move, and rename individual archives from within the 
PKZIP main application window. This functionality is available from the File menu.

Copy Archive 

To copy the active archive to a specified directory:

1. Verify that the file you wish to copy is the active file in the PKZIP main application window.

2. Select File | Copy Archive from the menu bar. The Copy Archive dialog appears.

3. Specify a destination directory for the archive. Use the Browse button if necessary. Click OK.

4. A dialog verifying the copy operation will appear. Click OK.

5. A copy of the archive now resides in the specified directory.

Delete Archive 

To delete the active archive:

1. Verify that the file you wish to delete is the active file in the PKZIP main application window.

2. Select File | Delete Archive from the menu bar. The Confirm File Delete dialog appears.

3. To delete the file click Yes. To cancel the delete operation click No.

Move Archive 

To move the active archive to a specified directory:

1. Verify that the file you wish to move is the active file in the PKZIP main application window.

2. Select File | Move Archive from the menu bar. The Move Archive dialog appears.

3. Specify a destination directory for the archive. Use the Browse button if necessary. Click OK.

4. A dialog verifying the move operation will appear. Click OK.

5. The archive will be moved from the source directory and should now reside in the specified directory.

Rename Archive 

To rename the active archive to a specified name:

1. Verify that the file you wish to rename is the active file in the PKZIP main application window.

2. Select File | Rename Archive from the menu bar. The Rename Archive dialog appears.

3. Specify a new name for the archive. It is not necessary to specify the extension. PKZIP will 
automatically append the appropriate file name extension. Click OK.



4. The archive is renamed to the specified file name.

Additionally, PKZIP for Windows allows you to copy and move files between two .ZIP (or .EXE) files. 
Copying a file involves taking a copy of a file and putting it into another .ZIP file. After copying, both .ZIP 
files contain a copy of that file. Moving a file involves transferring the file from one .ZIP file to another. 
After you move a file, it only resides in one .ZIP file. 

Since you cannot modify a spanned .ZIP file, you cannot move files from a spanned .ZIP file. You can 
only copy files. 

Moving Files Between Two Archives

To move files:

1. Within PKZIP for Windows, open the two .ZIP files. 

2. Click inside the .ZIP file from which you want to move files.

3. Highlight the files within the .ZIP file that you want to move. 

4. Click the right mouse button, or select Compress from the Menu bar. A menu appears.

5. Select Move To. The Move files dialog box appears.

If you selected files to move, the number of files you selected appears in the Files to Move area, and 
the Selected files radio button is selected by default. If you didn’t select files previously, the All files 
radio button is selected by default. The names of the .ZIP files you currently have open appear in the 
Opened archives box. 

6. If you are satisfied with the files you selected or all files, click on OK. If you didn’t select files, and you 
decide not to move “all” files, click Cancel, and repeat steps 3 through 6.

When you click OK, PKZIP for Windows begins to move the files to the other .ZIP or .EXE file.

Note:      You cannot use the Move To option to move files from or into encoded (e.g. *.UUE, *.XXE, 
*.MIM, *.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.

Copying Files Between Two Archives

To copy files:

1. Within PKZIP for Windows, open the two .ZIP files. 

2. Click inside the .ZIP file from which you want to copy files.

3. Highlight the files within the .ZIP file that you want to copy. If you want to copy “all” files from this .ZIP 
file, skip this step. In step 5, you will be able to change your selections. 

4. Click the right mouse button, or select Compress from the Menu bar. A menu appears.

5. Select Copy To. The Copy files dialog box appears.

If you selected files to copy, the number of files you selected appears in the Files to Copy area, and 
the Selected files radio button is selected by default. If you didn’t select files previously, the All files 
radio button is selected by default. The names of the .ZIP files you currently have open appear in the 



Opened archives area. 

6. If you are satisfied with the files you selected or all files, click on OK. If you didn’t select files, and you 
decide not to copy “all” files, click Cancel, and repeat steps 3 through 6.

When you click OK, PKZIP for Windows begins to copy the files to the other .ZIP or .EXE file.

Note:      You cannot use the Copy To option to copy files from or into encoded (e.g. *.UUE, *.XXE, *.MIM,
*.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



Moving Files
To move files:

1. Within PKZIP for Windows, open the two .ZIP files. 

2. Click inside the .ZIP file from which you want to move files.

3. Highlight the files within the .ZIP file that you want to move. 

4. Click the right mouse button, or select Compress from the Menu bar. A menu appears.

5. Select Move To. The Move files dialog box appears.

If you selected files to move, the number of files you selected appears in the Files to Move area, and 
the Selected files radio button is selected by default. If you didn’t select files previously, the All files 
radio button is selected by default. The names of the .ZIP files you currently have open appear in the 
Opened archives box. 

6. If you are satisfied with the files you selected or all files, click on OK. If you didn’t select files, and you 
decide not to move “all” files, click Cancel, and repeat steps 3 through 6.

When you click OK, PKZIP for Windows begins to move the files to the other .ZIP or .EXE file.

Note:      You cannot use the Move To option to move files from or into encoded (e.g. *.UUE, *.XXE, 
*.MIM, *.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



Copying Files
To copy files:

1. Within PKZIP for Windows, open the two .ZIP files. 

2. Click inside the .ZIP file from which you want to copy files.

3. Highlight the files within the .ZIP file that you want to copy. If you want to copy “all” files from this .ZIP 
file, skip this step. In step 5, you will be able to change your selections. 

4. Click the right mouse button, or select Compress from the Menu bar. A menu appears.

5. Select Copy To. The Copy files dialog box appears.

If you selected files to copy, the number of files you selected appears in the Files to Copy area, and 
the Selected files radio button is selected by default. If you didn’t select files previously, the All files 
radio button is selected by default. The names of the .ZIP files you currently have open appear in the 
Opened archives area. 

6. If you are satisfied with the files you selected or all files, click on OK. If you didn’t select files, and you 
decide not to copy “all” files, click Cancel, and repeat steps 3 through 6.

When you click OK, PKZIP for Windows begins to copy the files to the other .ZIP or .EXE file.

Note:      You cannot use the Copy To option to copy files from or into encoded (e.g. *.UUE, *.XXE, *.MIM,
*.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



The Copy/Move Dialog Boxes
If you are copying files, click here for information on this dialog box.

If you are moving files, click here for information on this dialog box.



Move File(s) From Dialog Box
You may access this dialog by clicking Compress | Move To... from the menu bar. The Move To...    
menu item is only available if you have two or more .ZIP files open in the PKZIP main application window. 
This Move file(s)... dialog box allows you to select the files that you want to move, and also displays 
relevant information about the move.

Move

This area allows you to select “all” files to move or only the files you selected in the .ZIP File Display 
Window.

All files

Click here to move “all” files in the .ZIP file.

Selected files

Click here to move only the selected files.

Files to Move

This area displays the number of files to move based on your selection in the Move area.

Opened archives

This box displays the .ZIP files that are currently opened.

Note:      You cannot use the Move To option to move files from or into encoded (e.g. *.UUE, *.XXE, 
*.MIM, *.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



Copy File(s) From Dialog Box
You may access this dialog by clicking Compress | Copy To... from the menu bar. The Copy To...    menu
item is only available if you have two or more .ZIP files open in the PKZIP main application window. The 
Copy file(s)... dialog box allows you to select the files that you want to copy, and also displays relevant 
information about the copy.

Copy

This area allows you to select “all” files to copy or only the files you selected in the .ZIP File Display 
Window.

All files

Click here to copy “all” files in the .ZIP file.

Selected files

Click here to copy only the selected files.

Files to Move

This area displays the number of files to copy based on your selection in the Copy area.

Opened archives

This box displays the .ZIP files that are currently opened.

Note:      You cannot use the Copy To option to copy files from or into encoded (e.g. *.UUE, *.XXE, *.MIM,
*.MME, *.HQX) and archived (e.g. *.TAR, *.TGZ, *.GZ) files.



Using Right Click to Display PKZIP Task Menu
You may click on your right mouse button within a .ZIP file to display a quick menu of common PKZIP for 
Windows tasks.

To use this feature:

1. Open a .ZIP file. 

2. Inside the .ZIP file, click on your right mouse button. A task menu appears.

If you have more than one .ZIP file open, two additional options, Move To and Copy To, will appear on this
menu.

Select this option: To:

Open Open files within a .ZIP file.

Extract Extract files from a .ZIP file.

Test Test files within a .ZIP file.

Add Add files to a .ZIP file.

Delete Delete files from a .ZIP file.

Convert Convert one type of .ZIP file to another.

Cancel Close this menu.

What happens when you select an option from this menu is the same as when you select from the PKZIP 
for Windows Menu bar. For example, when you select Extract, the Extract dialog box appears, just as if 
you had selected Extract from the Extract menu on the Menu bar.



Using the Windows Explorer 
PKZIP for Windows allows you to perform the following PKZIP for Windows tasks using the right click 
feature of the Windows Explorer, or selecting File | New from the Explorer menu.

· Create a new .ZIP file.

· Open an existing .ZIP file.

· Extract from a .ZIP file.

· Test a .ZIP File.



Creating a .ZIP File With Windows Explorer
To create a new .ZIP file:

1. Start the Windows Explorer.

2. Click the right button of your mouse anywhere inside the Explorer window. The Explorer menu 
appears.

3. Select New. The New menu appears.

4. Select PKZIP File. The icon for the .ZIP file appears, with the icon label (the text that accompanies 
the icon) enabled.

5. Type a label for your .ZIP icon by highlighting the text that already appears and typing the label. 

6. To add files to your new .ZIP file, double-click your left mouse button on the icon you just created. 
PKZIP for Windows starts and the .ZIP file opens. Add files, as necessary.



Opening a .ZIP File With Windows Explorer
To open a .ZIP file:

1. Start the Windows Explorer.

2. Click the right mouse button on the .ZIP file. The Explorer menu appears.

3. Select Open. PKZIP for Windows starts and the .ZIP file opens.



Extracting Files From a .ZIP File With Windows Explorer
To extract files from a .ZIP file:

1. Start the Windows Explorer.

2. Click the right mouse button on the .ZIP file. The Explorer menu appears.

3. Select Extract To. PKZIP for Windows starts and the Extract dialog box appears.



Testing Files in a .ZIP File With Windows Explorer
To test files within a .ZIP file:

1. Start the Windows Explorer.

2. Click the right mouse button anywhere inside the Explorer window. The Explorer menu appears.

3. Select Test. PKZIP for Windows starts and the Test dialog box appears.



Viewing a .ZIP File Comment
To view a .ZIP comment:

1. Open a .ZIP file. 

2. From the Menu bar, select Compress. The Compress menu appears.

3. Select View Comment. The .Zip Comment box appears. If a comment exists for this .ZIP file, it will 
appear in that box.

4. When you have finished viewing the comment, click on Cancel. The dialog box disappears.

The Read only message at the bottom of the .ZIP Comment box indicates that you cannot edit the 
comment.



Viewing .ZIP File Statistics
You can view the following statistics for a selected .ZIP file:

· Files in .ZIP - the number of files within the .ZIP file.

· Uncompressed Size - The normal, uncompressed size of all the files combined.

· Compressed Size - The compressed size of all the files combined.

· Compression Ratio - The ratio of the compressed size to the uncompressed size.

To view .ZIP statistics:

1. Open a .ZIP file.

2. Do one of the following:

3. From the Menu bar, select Compress | Statistics.

4. A dialog box appears that contains the statistics for that .ZIP file.



Creating .ZIP Files With the PKZIP Wizard
The PKZIP for Windows Wizard systematically guides the novice user through the steps necessary to 
compress files into a .ZIP archive. To access the Compression Wizard:

1. Run PKZIP for Windows. The PKZIP for Windows main application screen appears.

2. From the Menu bar, select File | Wizard or click the  item on the tool bar. A dialog labeled PKZIP 
for Windows Wizard - Welcome will appear.

3. Click the radio button next to the Compress files into a new .ZIP file option.

4. Click the Next button. The wizard will proceed to the next dialog.

5. Follow the instructions on the various wizard dialogs.

 



Extracting Files From a .ZIP File
Extracting files from a .ZIP file is as easy as compressing. You can extract a single file or multiple files. 

To extract files:

1. Open the .ZIP file from which you want to extract. PKZIP for Windows displays the .ZIP file.

2. Select the files you want to extract. To select a file, hold down your CTRL key and click on that file. To 
select a group of files, hold down the left mouse button and drag over the files. You can also use the 
Select option on the Menu bar.

3. From the Menu bar, select Extract. The Extract menu appears.

4. Select Extract files. The Extract files dialog box appears.

The Extract area in this dialog box indicates that you are extracting all of the files from the .ZIP file or 
just selected files.

The Statistics area contains the number of files being extracted and the total number of bytes for 
those files. This area is informational only.

The Extract to area allows you to select a destination for the files being extracted.

The Password area allows you to enter a password for the .ZIP file, if necessary.

5. If the .ZIP file you are extracting from contains a password, you must enter that password before you 
can extract files. Type the password in the Password box.

If the .ZIP file doesn’t contain a password, leave the Password box blank.

6. Select a destination for the files being extracted. You may either extract to your hard disk or to a 
printer. If you extract to your hard disk, you may either type a location - such as a drive or directory 
path - or you can use the Browse button to access your hard drive for a location. Click the Create 
Directory button to create a destination directory.

7. Set    Preferences , if needed, by clicking on the Preferences button and clicking on the appropriate 
radio buttons and checkboxes. 

8. When you have finished selecting a destination, click on Extract to start extracting.    PKZIP for 
Windows displays the Extract box.

As PKZIP for Windows extracts the files, it displays the status of the extraction process in the 
Progress area of the dialog box. The name of the current file being extracted appears next to the 
word Filename.    The percent completion changes as it extracts. As each file is extracted, an OK 
appears next to that file.      At the bottom of the dialog box, PKZIP for Windows displays the number    
of warnings.

9. When the last file is extracted, PKZIP for Windows displays a “Done” message. When you see this 
message, click on the Done button to exit.



Testing the Integrity of a .ZIP File
We recommend that you test the integrity of a .ZIP file before you extract from it. If a file within a .ZIP file 
is bad or corrupt, you might not be able to extract that file. 

To test files:    

1. Open the .ZIP file you want to test. PKZIP for Windows displays the .ZIP file.

2. Select the files you want to test. To select a file, click on that file. You can also use the Select option 
on the Menu bar.

3. From the Menu bar, select Extract. The Extract menu appears.

4. Select Test files. The Test Files dialog box appears.

The File Selection area indicates that you are testing all files in the .ZIP file or selected files. If you 
selected all files you cannot change this area. If you selected only some of the files, you can change 
your mind here and click on All files.

The Statistics area contains the number of files being tested and the total number of bytes for those 
files. This area is informational only.

The Password area allows you to enter the password for this .ZIP file, if necessary. 

5. If the .ZIP file you are testing contains a password, you must enter that password before you can test 
files. Type the password in the Password box. 

If the .ZIP file doesn’t contain a password, leave the Password box blank.

6. To start testing, click on Test Integrity. PKZIP for Windows begins to test the file(s) and displays the 
Test Zip box.

As PKZIP for Windows tests the files, it displays the status of each file individually and of the entire 
test, in the Progress area of the dialog box. The name of the current file being tested appears next to 
the word Filename.    The percent completion changes as it tests. As each file passes the test, an OK 
appears next to that file. At the bottom of the dialog box, PKZIP for Windows displays the number of 
warnings and errors.

7. When the last file is tested, PKZIP for Windows displays a “Done” message. When you see this 
message, click on the Done button to exit.



Extracting From a Windows Self-Extractor
Extracting files from a Windows self-extractor is quick and easy. With a self-extractor, you don’t have to 
start PKZIP for Windows to extract files. 

This section contains instructions on extracting from “outside” PKZIP for Windows. From within PKZIP for 
Windows, extracting from a self-extractor works the same as a regular .ZIP file.

To extract from a Windows self-extractor:

1. Locate the file using the Windows File Manager (for Windows 3.1x and Windows NT 3.51) or with My 
Computer or Explorer (for Windows 95 and Windows NT 4.0). This file should have a .EXE extension.

2. Double-click your left mouse button on the self-extractor. The PKSFX extract dialog box appears.

Some of the items in this dialog box default from the PKZIP for Windows - Options dialog box, which 
is the one used to set options when the self-extractor was created. Items that are disabled cannot be 
edited. 

3. Complete the appropriate items. Set options, as necessary. A description of each “button” in this 
dialog box follows.

About button

Click on this button to get general information on PKZIP for Windows licensing and disclaimers.

Information button

Click on this button to read additional information included with this self-extractor. If the creator of the 
self-extractor did not include a comment, this button will be disabled.

Test button

Click on this button to perform a “test” extraction. 

Extract button

Click on this button to extract the files from the self-extractor onto your computer. 

Cancel button

Click on this button to cancel the extraction. 

4. When you have finished with this dialog box, click on Extract. PKZIP for Windows begins to extract 
the files.



Extracting From a DOS Self Extractor
To extract files from a DOS self-extracting .ZIP file (a .ZIP file with a .EXE extension), you do not have to 
use PKZIP for Windows. You can extract directly from your Windows File Manager, or from a DOS 
prompt. In both cases, PKZIP for Windows opens a DOS window when it begins to extract.

Extracting Using the Windows Explorer or File Manager

To extract files using the Windows Explorer or File Manager:

1. Locate the file using the Windows Explorer or File Manager. The file should have a .EXE extension.

2. Double-click on the .EXE file. A DOS window opens and the files within the self-extracting file are 
extracted into the directory where the self extractor (.EXE) resides.

Extracting Directly From a DOS Prompt

To extract files from a self-extracting .ZIP file “without” using the File Manager, you may simply open a 
DOS window and type the name of the self-extracting file. This method works like PKZIP for DOS . You 
may specify locations, special options, and also extract individual files.

When you extract from a self-extracting file, all you have to do is type the name of the .EXE file. This file 
contains the necessary commands and programs you need to extract the file. 

In general, to extract files:

1. Open a DOS window by clicking on the MS-DOS icon.

2. Change to the directory where the self-extracting (.EXE) file resides.

You can type the location as part of the command in step 3.

3. At the DOS prompt (for example, C:\), type the name of the .EXE file you are extracting from and 
press ENTER. For example, if the name of the file is apples.exe, you would type apples. (You do not 
have to type the .EXE.)

To add flexibility to your self-extraction, you can also specify:

· A location for the file(s) being extracted.

· Individual files to extract.

· Options that add flexibility to your extraction.

Specifying a Location
PKZIP for Windows extracts the files into the directory you are in, unless you change that location. To 
change locations, you can type the drive and/or path. For example, if you were extracting from a file 
called “apples.exe” and you wanted to extract it to the D drive in the fruit\temp directory, you would type     
the following:

apples.exe        d:\fruit\temp



Selecting Individual Files to Extract
When you extract files, you do not have to extract all of the files from the .EXE file. You can extract as 
many as you want. For example, if you wanted to extract two files from the apples.exe file, and the names
of those files are sour.doc and sweet.doc, you would type the following:

apples.exe      sour.doc      sweet.doc

You can also use DOS wildcards to specify a file pattern. For example, if you wanted to extract all files 
that end in .DOC, you would type something similar to the following:

apples.exe    *.DOC

This feature is not available for PKSFX-Jr.

Specifying Options
With self-extracting files, PKZIP for Windows provides several options that help customize your data 
extraction. When you use an option, it must appear as the first element after the name of the .EXE file in 
your command. For example, the -d option allows you to re-create directories in the location in which you 
are extracting the files. To do this, you would type something similar to the following:

apples.exe    -d      *.DOC

You can use more than one option in the same command. Type the options right next to each other, 
“except” when using the -s option.

The following is a description of each option. The -o and -h    options are the only options that apply to 
PKSFX-Jr.

This option: Allows you to:

-c Extract to the console.

-d Re-create directories that are stored in the .EXE file.

-l Display the software license agreement on your screen.

-n Extract only files that are newer than the corresponding files in 
your destination (extract) directory.

-o Overwrite existing files of the same name in your destination 
(extract) directory.

-p [a] [b] [c] [#] Extract to a printer.

a=Extract in ASCII Mode (e.g. -pa1)
b=Extract in BINARY Mode (e.g. -pb2)
c=Extract to specified COM port (e.g. -pac1)

-s [password] Decrypt with a password.

-t Test the integrity of the .ZIP file.

-h or \? Get online help on using these options.



Extracting From a Spanned .ZIP File
To extract files from a spanned .ZIP file:

1. Insert the “last” diskette in your series of your spanned .ZIP file. For example, if the .ZIP file spans 
three diskettes, insert the third diskette.

2. Using PKZIP for Windows, open the .ZIP file from which you want to extract.

3. Select the Extract option from the Extract menu, or click on the “extract” Toolbar button. The Extract 
dialog box appears.

4. Proceed with selecting the files to extract, setting preferences, and so on. 

5. When you are finished, click OK in the Extract dialog box. PKZIP for Windows displays the following 
message:

Insert Disk #1

6. Insert the first diskette in the series and click OK. PKZIP for Windows begins to extract from that 
diskette. When it finishes, the following message appears:

Insert Disk #2

7. Insert the next diskette and click OK. Repeat these steps for any additional diskettes. 

When the PKZIP for Windows extracts from the final diskette, the Done message appears.



Extracting From a Spanned .EXE (self-extractor) File
These instructions show you how to extract “all” files from a spanned self-extractor without starting PKZIP
for Windows. To extract individual files from a spanned file, you have to start PKZIP for Windows first, 
then open the appropriate .EXE file.

To extract all files from a spanned Windows self-extractor:

1. Insert the first diskette in the series of your spanned self-extractor.

2. Double-click your left mouse button on the self-extractor icon. The following message appears:

Insert last disk

3. Insert the “last” diskette in the series of your spanned self-extractor. For example, if the self-extractor 
spans three diskettes, insert the third diskette.

4. When you have inserted the last diskette, the PKSFX dialog box appears.

Some of the items in this dialog box default from the PKZIP for Windows - Options dialog box, which 
is the one used to set options when the self-extractor is created. Items that are disabled (e.g., 
Recreate subdirectories) cannot be edited. 

5. Complete the necessary items. A description of each “button” in this dialog box follows.

About button

Click on this button to get general information on PKZIP for Windows licensing and disclaimers.

Information button

Click on this button to read additional information included with this self-extractor. If a comment was 
not included, this button will be disabled.

Test button

Click on this button to perform a “test” extraction. 

Extract button

Click on this button to extract the files from the self-extractor onto your computer. 

Cancel button

Click on this button to cancel the extraction. 

6. When you have finished with this dialog box, click on Extract. The following message appears:

Insert Disk #1

7. Insert the first diskette in the series, and click OK. PKZIP for Windows begins to extract from the self-
extractor. 

The status of extracting files appears at the bottom of the PKSFX dialog box. 



When PKZIP for Windows is finished with this diskette, the following message appears:

Insert Disk #2

8. Insert the next diskette and click OK. Repeat these steps for any additional diskettes. 

When PKZIP for Windows extracts from the final diskette, the Extract dialog box will disappear.



Opening a File Within a .ZIP File
You can open a file that appears within a .ZIP file. For example, if your .ZIP file contains a    
README.TXT file, you can open that file while you are in the .ZIP file. 

To open a file within a .ZIP file:

1. Open your .ZIP file. 

2. Click your left mouse button “once” on the file within the .ZIP file that you want to open. That file is 
highlighted.

3. Do one of the following:

From the Extract menu, select Open. The file you selected opens in the associated application. 

Double-click your left mouse button on the file within the .ZIP file. The file you selected opens in the 
associated application.

If PKZIP for Windows does not recognize the file you are trying to open, the following message appears:

No File Association For This Type

Add the appropriate file extension to your Windows registry (Windows95) or WIN.INI file (Windows 3.1 or 
greater).



Extracting Files Using the PKZIP Wizard
The PKZIP for Windows Wizard systematically guides the novice user through the steps necessary to 
extract files contained in a .ZIP archive. To access the Extraction Wizard:

1. Run PKZIP for Windows. The PKZIP for Windows main application screen appears.

2. From the Menu bar, select File | Wizard or click the  item on the tool bar. A dialog labeled PKZIP 
for Windows Wizard - Welcome will appear.

3. Click the radio button next to the Extract all files stored in an existing .ZIP file option.

4. Click the Next button. The wizard will proceed to the next dialog.

5. Follow the instructions on the various wizard dialogs.

 



Viewing Files Within a .ZIP File
When you open a .ZIP file, you might want to view the contents of one of the compressed files. PKZIP for 
Windows allows you to open individual application files right from the .ZIP File Display Window.

To view the contents of an application file:

1. Open the desired .ZIP file.

2. Specify a temporary directory for PKZIP for Windows to extract the file. To do this, select Extract from
the Menu Bar, Preferences from the Extract menu, and enter the directory in the Temporary Extract 
Directory box.

3. Select the file you want to view by double-clicking on the file. PKZIP for Windows automatically 
extracts the file into the temporary directory, and the file opens.

The file you open needs to have a Windows file association for that type of file.    For example, to view the 
WIN.HLP file, which has a windows file association of Winhelp for .HLP files, double clicking will cause 
winhelp to run the WIN.HLP file.

If there is no file association for that file type, an error message appears. Please refer to your Windows 
documentation for further information about file associations.

 



PKZIP Viewing Options

PKZIP for Windows contains several different options to view a .ZIP file. These options appear on the 
View menu. 

The GridLines option allows you to turn on and off the gridlines that border the list of files.

The Zoom In option allows you to zoom “in” to the .ZIP file contents. 

The Zoom Out option allows you to zoom “out” of the .ZIP file contents. 

The Font option allows you to change the font name, style, and size of the text within the .ZIP File Display
Window.



Sorting Files Within a .ZIP File

PKZIP for Windows allows you to sort the files within a .ZIP file on your screen several different ways, 
making it easier to find the files that you want. 

To sort files, use the Sort option on the Menu bar.

Sort by Filename in ascending or descending order. Ascending is normal alphabetical order. Descending
is reverse alphabetical order.

Sort by Extension in ascending or descending order. Ascending is normal alphabetical order. 
Descending is reverse alphabetical order.

Sort by File Size in ascending or descending order. Ascending is from smallest to largest. Descending is 
from largest to smallest.

Sort by Date in ascending or descending order. Ascending is from oldest to newest. Descending is from 
newest to oldest.

Sort by Compression Ratio in ascending or descending order. Ascending is from smallest to largest. 
Descending is from largest to smallest.

Sort by CRC 32 value in ascending or descending order. Ascending is from smallest to largest. 
Descending is from largest to smallest.

Unsorted does not sort the files. They appear in the order that they were compressed.



Cascade and Tile .ZIP Files

You might find it necessary to open multiple .ZIP files at the same time. PKZIP for Windows makes it 
easier to view these files by providing two ways to arrange the .ZIP File Display Windows that contain 
them.

To arrange windows, use the Windows option on the Menu bar.

Cascade - This option allows you to place the .ZIP File Display Windows on top of each other, with only 
the top part of each window showing. Each window is slightly lower and to the right of the one below it. 
You can still access all files, you just can't see the entire contents of the each .ZIP file.

Tile -    This options allows you to give equal space to every window you have opened. You can see the 
partial contents of each window,    but each one is relatively small.



Compress Preferences

When you create a new .ZIP file or add files to a .ZIP file, you can change various .ZIP parameters. This 
provides greater flexibility for compressing files.

When you select Preferences from the Compress menu, or click on the Preferences button in the Add 
Files dialog box, PKZIP for Windows displays the Compress Preferences dialog box.

To set the changes as the new defaults, click on Save as default “instead” of OK. This sets defaults for 
“all” changes made in this box. To specify which directory will appear by default in the Add files dialog, the
Open dialog, as well as the PKZIP temporary directory, click the Directories button. The Directories 
dialog will appear.      

Compression

This area allows you to change the compression method. Click on the radio button that appears next to 
the method you want to use.

Super fast - Use this method if want the fastest - but least - compression. If speed is a priority, this 
method is for you.

Fast - Use this method if you want the second fastest compression and the second least compression. 
This method is slower than Super fast but provides more compression.

Normal - Use this method if you want the best balance of speed and compression. This is the default 
method. 

Extra - Use this method for the most - but slowest - compression. If compression is a priority, this method 
is for you. 

Store - Use this method if you want no compression, or if you know that a file will not compress. 

Attributes

This area allows you to include files in your .ZIP file that contain specific attributes. You can select as 
many file attribute types as you want. 

Read-Only -    Compress read-only files.

Hidden - Compress hidden files. (Hidden files cannot be displayed in Add Files or using the DOS dir 
command. They are displayed within a .ZIP file.)

System - Compress system files. These files are used by the operating system.

Retain attributes - Retain the attributes in the .ZIP file so you can extract the files with the attributes.

.ZIP File Date

This area allows you to set the date of a .ZIP file. Click on the radio button that appears next to the date 
you want to use.



Today's date - Apply today's date to the .ZIP file.

Newest date - Apply the date of the newest file within the .ZIP file to the .ZIP file.

Oldest date - Apply the date of the oldest file within the .ZIP file to the .ZIP file.

Retain .ZIP date - Keep the current date of the .ZIP file.

Path Information

This area allows you to store directory path information in your .ZIP file. For example, if you compressed 
a file from the \doc\resume directory, you can include the “\doc\resume” in your .ZIP file.

No path information - Do not include path information with each file in the .ZIP file; only include the 
filename.

Relative path - Include relative path information with each file in the .ZIP file.

Full path - Include the entire path with each file in the .ZIP file. 

Use MS-DOS name - Store the 8-character name, 3-character extension for files compatible with this 
MS-DOS naming convention.

Archive Bit

ZIP if archive bit is set - Compress files that have had their archive bit set, which means the file has 
changed since the last backup.

Clear archive bit - Clear the archive bit after the file is compressed.

Miscellaneous

This area contains more options that add flexibility to your data compression.

Store Volume Label -    Store the volume label from the desired drive within the .ZIP file.

Include Subdirectories (Recurse) - Compress files that appear in subdirectories of the current directory.
If you use this option, you don't have to select the files within each subdirectory. If you selected specific 
files to be compressed, PKZIP for Windows will include only files within the subdirectories that match that 
criteria.

Set 204g file limit - Ensures PKZIP for DOS 2.04g    compatibility for .ZIP files created with PKZIP for 
Windows by setting the limit on the number of files that can be added to a .ZIP archive from 65,535 to 
16,383.



Extract Preferences

When you extract a file from a .ZIP file, PKZIP for Windows allows you to change various .ZIP 
parameters. This provides greater flexibility for extracting files.

When you select Preferences from the Extract menu, or click on the Preferences button in the Extract 
Files dialog box, PKZIP for Windows displays the Extract Preferences dialog box.

To set the changes you make in this dialog as the new defaults, click on Save As Default instead of OK. 
This sets defaults for “all” changes made in this box.

Extract Options

This area allows you to control how PKZIP for Windows handles files being extracted that have the same 
name as files in the target directory (the directory you are extracting to). 

Overwrite - Overwrite files in the target directory without prompting you.

Update - Extract files that contain a file with the same name and date in the target directory “and” that are
newer than the files in the target directory.

Update & New - Extract files that contain a file with the same name in the target directory, is newer than 
the file in the target directory, “and” any files that are not in the target directory.

Prompt user - Prompt you to overwrite or not overwrite a file in the target directory.

Restore Attributes

This area allows you to restore the file attributes for the files being extracted. You can select as many of 
these file attribute types as you want.

Read-only - Restore the read-only attribute for affected files.

Hidden - Restore the hidden attribute for hidden files that are extracted.

System - Restore the system attribute for system files that are extracted.

Options

This area contains more options that add flexibility to your data extraction.

Create directory - Restore the directory structure for the files that are extracted.

Restore volume label - Restore the volume label if a .ZIP file contains one.

Temporary Extract Directory

This area allows you to specify a temporary extract directory for when PKZIP for Windows temporarily 
extracts files. PKZIP for Windows uses the temporary extract directory as work area in which to 
temporarily extract files.





View Preferences

When you view files within a .ZIP file, PKZIP for Windows allows you to change various viewing 
parameters. This provides greater flexibility for viewing files. The changes you make in this box affect 
all .ZIP files you have open.

When you select Preferences from the View menu,    PKZIP for Windows displays the View Preferences 
dialog box.

To set the changes you make in this dialog as the new defaults, click on Save as default instead of 
clicking on OK. This sets defaults for “all” changes made in this box.

Display

This area allows you to control    the categories of information PKZIP for Windows displays for each file 
within a .ZIP file. When you first display the View Preferences dialog box, all categories are displayed. 
Turn off and on the categories that you want. 

File Size - Display the size of the file before it was compressed.

File Date/Time - Display the time and date of the file.

Attributes - Display the attributes of each file.

Compressed Size - Display the size of the compressed file.

Compression Ratio - Display the ratio of compression for each file.

CRC 32 - Display the Cyclic Redundancy Check (CRC) value for each file.

Comment - Display the comment, if one exists.

Method - Display the compression method PKZIP for Windows used when compressing.

View

This area allows you to include or exclude gridlines and row numbers in the .ZIP File Display Window. 
When you first display the View Preferences dialog box, all view options are turned on.    Turn off and on 
the options that you want. 

Grid Lines - Display gridlines that border the .ZIP File Display Window.

Row Numbers - Display the row numbers that appear to the left of each file.

Sort By

This area allows seven different ways to sort the files within a .ZIP file.

Filename - Sort files by filename.

Extension (type) - Sort files by file extension (for example, .TXT). 



File Size - Sort files by file size.

File Date/Time - Sort files by date and time.

Compress ratio - Sort by compression ratio, which is the ratio of uncompressed size to compressed size.

CRC 32 - Sort by CRC (Cyclic Redundancy Check) value. 

Unsorted - Do not change the sort order displayed when you first opened a .ZIP file. 

Sort Order

This area coincides with your selection in the Sort By area and allows you to sort in ascending or 
descending order. 

Ascending/Descending:    

by filename - Ascending is normal alphabetical order. Descending is reverse alphabetical order.

by extension -  Ascending is normal alphabetical order. Descending is reverse alphabetical order.

by file size    - Ascending is from smallest to largest. Descending is from largest to smallest.

by date/time - Ascending is from newest to oldest. Descending is from oldest to newest.

by compress ratio - Ascending is from smallest to largest. Descending is from largest to smallest.

by CRC 32  - Ascending is from smallest to largest. Descending is from largest to smallest.

unsorted - Ascending and Descending does not apply to this sort method.

Misc

Save column widths - Save the current column widths of the .ZIP File Display Window. PKZIP for 
Windows allows you to adjust the widths of the columns. If you do not check this box, your column widths 
will not be saved for the next session.

 



Opening an Existing .ZIP File

You can open a .ZIP file in PKZIP for Windows several different ways. You can:

1. Start PKZIP for Windows, then using the File Manager or Explorer, drag the file onto the PKZIP for 
Windows main application window or icon.

2. Start PKZIP for Windows, then select the file from the list of most recently-opened files on the File 
menu. This list appears at the bottom of the File menu.    

3. Start PKZIP for Windows, select File from the Menu bar and Open from the File menu. PKZIP for 
Windows displays the Open File dialog box.

4. If you are using Windows95 or Windows NT, open a DOS window and type PKZIPW and the name of 
the .ZIP file.

5. If you are using Windows 3.X, use the Run (program) option and type PKZIPW and the name of 
the .ZIP file.



Selecting Files

You can select files in several different ways. You can use the PKZIP for Windows Tool bar or the Select 
option on the Menu bar.

Selecting All Files

To select all files in the .ZIP file that are opened, click the  button on the PKZIP for Windows Tool bar. 
To unselect all files, click on the 

 button on the PKZIP for Windows Tool bar.      

Selecting Files Based On Filename

To select files by filename:

1. Using the PKZIP for Windows Tool bar, click on the  toolbar button. 

2. Using the PKZIP for Windows Menu bar, choose Select from the Menu bar. 

3. Click By Filename. The Select by filename dialog box appears.

4. Type a filename or file pattern in the Enter the file pattern: box. You can use DOS wildcards, even 
multiple ones at the same time (for example, *drive*    B*). To consider case, click in the Case 
sensitive checkbox. To ignore pathnames in your selection, click in the Ignore Path Names 
checkbox.

5. When you have finished typing a filename or file pattern, click on OK. Your files are selected and 
PKZIP for Windows highlights those files in the .ZIP File Display Window.

Selecting Files Based On File Size

To select files by file size:

1. Using the PKZIP for Windows Tool bar, click on the  toolbar button. 

Using the PKZIP for Windows Menu bar,    choose Select from the Menu bar. 

2. Click By File Size. The Select by file size dialog box appears.

3. Select the criteria for specifying file size. The Select by file size dialog box contains a combo-box, with
the following choices:

Less than
Greater than
Equal
Between

Select one of these by clicking on the item you want, then type the size on which you are going to 
base the selection. For example, if you want to select all files that are less than 1000 bytes, you would
click on less than, then type 1000 in the box that appears next to the word bytes.

4. When you have finished specifying the size, click on OK. The files are selected and PKZIP for 
Windows highlights those files in the .ZIP File Display Window.



Selecting Files Based On File Date

To select files by file date:

1. Using the PKZIP for Windows Tool bar, click on the  toolbar button. 

Using the PKZIP for Windows Menu bar,    choose Select from the Menu bar. 

2. Click By File Date. The Select by file date dialog box appears.

3. Select the criteria for specifying file size. The Select by file date dialog box contains a combo-box, 
with the following choices:

Before
Equal to
After
Between

Select one of these by clicking on the item you want, then type the date on which you are going to 
base the selection. For example, if you want to select all files that were created after 12/10/1994, you 
would click on before, then type 12101994 in the box that appears next to the (MM/DD/YYYY).

4. When you have finished specifying date, click on OK. The files are selected and PKZIP for Windows 
highlights those files in the file display box.



Cascade .ZIP File Windows

Use this command to overlap each .ZIP File Display Window. Each window is slightly lower and to the 
right of the one above it.    



Tiling .ZIP File Windows

Use this option to arrange multiple-opened .ZIP files so that each .ZIP File Display Window is given equal 
size. 



Current .ZIP Files Open

PKZIP for Windows displays a list of currently open .ZIP files at the bottom of the Window menu.    A 
checkmark appears in front of the document name of the active window.    “Active” means the file is 
currently highlighted. Click on a different window to make it active.



Help Index Option
 

Use this option to display the main Help screen.    From this screen, you can jump to additional Help 
screens that contains step-by-step instructions on using PKZIP for Windows.    

To return to the main Help screen from anywhere, click on the Contents button.



Using Help Option

Use this option for instructions on using Help.



About Option

Use this option to display the copyright notice and version number of your copy of PKZIP for Windows.



License Option

Use this option to get general product license information. 



New .ZIP File Command

Use this command to create a new .ZIP file.    

To open an existing .ZIP file, use the Open command

Shortcuts

Keys: CTRL+N



Open Existing .ZIP File

Use this option to open an existing .ZIP. PKZIP for Windows allows you to browse your hard drive to 
locate the .ZIP file.

To create a new .ZIP file, use the New command.

Shortcuts

Keys: CTRL+O



Open Dialog Box

You may access this dialog by clicking the Open button on the toolbar or selecting File | Open from the 
menu bar. The following items allow you to specify a file to open:

Note: The items in this dialog box will be slightly different for Windows 16-bit and Windows NT version 
3.51. 

Look in
Select the drive and directory in which you want to store the file. In the Windows 16-bit/NT 3.51 Open 
dialog you may use the Folders and Drives boxes as well as the Network button to specify this 
information.    

File name
Type a new file name to save a file with a different name. 

(List) Files of type
Select the type of file you want to create.    For example, the file may be a standard .ZIP file, a self-
extracting file (.EXE), or a Windows self-extracting file (.EXE).



Close .ZIP File Option
 

Use this option to close the active .ZIP file.    



Most Recently-Used .ZIP Files

Use the numbers and filenames listed at the bottom of the File menu to open the last four .ZIP files you 
closed.    Select the number or click on the name that corresponds with the .ZIP file you want to open.



Exit PKZIP 
 

Use this option to end this PKZIP for Windows session.

Shortcuts

Mouse: Double-click the application's Control menu button.

              Keys: ALT+F4



Extract Dialog Box

This box shows information on extracting files.

See Also:

Extracting Files From a .ZIP File



Test Dialog Box

This box shows information on testing.

See Also:

Testing .ZIP File Integrity



Add Status Box

This box appears when you add files to a new or existing .ZIP file.

See Also:
Adding Files to an Existing .ZIP File

Creating a New .ZIP File



Overwrite Existing File

This message box appears when you extract a file from a .ZIP file and there is a name conflict. A name 
conflict occurs when a file being uncompressed has the same name as a file already on the destination 
disk drive.    



Browse Dialog

This dialog allows you to search for the desired drive and directory. Select the appropriate drive from the 
Drives drop-down list. Select the appropriate file directory from the Directory box. Click the Network 
button to map a network drive. Click OK to complete your drive and directory selection.    



Manual Add Dialog Box

This box allows you to manually type the filename or file pattern you want to compress (instead of 
selecting it from a list). You can use DOS wildcards. For example, to compress all files that end in .TXT, 
you could type *.TXT.



Save As Dialog Box

The following options allow you to specify the name, location, and type of file you're about to create or 
convert:

Note: The items in this dialog box will be slightly different for Windows 16-bit and Windows NT version 
3.51. 

Save in
Select the drive and directory in which you want to store the file. In the Windows 16-bit/NT 3.51 Save 
As dialog you may use the Folders and Drives boxes as well as the Network button to specify this 
information.    

File name
Type a new file name to save a file with a different name. 

Save (file) as type
Select the type of file you want to create.    For example, the file may be a standard .ZIP file, a self-
extracting file (.EXE), or a Windows self-extracting file (.EXE).



Directories Dialog Box
This dialog allows you to specify the following default directory information:

Add files default directory
Click the appropriate option in this group box to define which directory will appear in the Add Files 
dialog by default.

· System Default Directory - The directory defined by your system will be used.

· Active ZIP Directory - The directory where the currently active .ZIP file resides will be used.

· Last Add files directory - The directory that you specified when you last added files will be 
used.

· Specified directory - The directory specified in the text box will be used. If necessary, use the 
Browse button to locate this directory. 

Open ZIP default directory
Click the appropriate option in this group box to define which directory will appear in the Open dialog 
by default.

· System Default Directory - The directory defined by your system will be used.

· Active ZIP Directory - The directory where the currently active .ZIP file resides will be used.

· Last Open files directory - The directory that you specified when you last opened a file will be 
used.

· Specified directory - The directory specified in the text box will be used. If necessary, use the 
Browse button to locate this directory. 

Temporary .ZIP file directory
· Specify the directory you want PKZIP to use temporarily while it creates and updates .ZIP 

files. If necessary, use the Browse button to locate this directory. 



Associating the .ZIP Extension with PKZIP 

By default, the PKZIP install program registers the PKZIP for Windows program with the .ZIP filename 
extension. This allows you to open .ZIP files from Windows Explorer or File Manager without opening 
PKZIP first. PKZIP automatically starts when you double-click on the filename in Explorer or File 
Manager. This .ZIP extension association can be disabled on install or potentially changed by other install
programs. As such, PKZIP allows you to manually set the .ZIP extension association to PKZIP for 
Windows. To manually associate PKZIP for Windows (pkzipw.exe) with the .ZIP filename extension, 
complete the following steps: 

1. Run PKZIP for Windows. If the .ZIP filename extension is not presently associated with the version of 
PKZIP you are running, the Set association dialog will appear. Proceed to step 4. If the Set 
association dialog is disabled or the .ZIP filename extension is already associated with PKZIP, this 
dialog will not appear on startup. If you are unsure as to whether the .ZIP filename extension is 
registered to PKZIP for Windows, you may proceed to step 2. 

2. Click File | Associate to .ZIP on the menu bar. If the file association is already set up properly, the 
Associate to .ZIP item will be grayed out. If the file association is not presently set up, you may select 
this item from the File menu. The Set Association dialog will appear:

3. If you wish to continue by associating the .ZIP extension with PKZIP for Windows click the Yes 
button. To exit without changing the association, click the No button.

Please confirm before you click the No button whether you wish to be prompted with this dialog each 
time you run PKZIP for Windows. If you do not wish to be prompted, check the Do not ask me this 
question on startup checkbox. 



Uninstalling PKZIP for Windows

To uninstall PKZIP for Windows:

1. Locate the PKWARE Program Group. If you are unable to find a Program Group for PKWARE, use 
Windows File Manager or Explorer to locate the installation directory. (\pkware\pkzipw by default).

2. Run the PKZIP for Windows Uninstall program (pkuninst.exe) by double clicking the appropriate icon.

    
3. A dialog labled Uninstall PKZIP for Windows will appear displaying the specific components    that will 

be uninstalled. Verify that you wish to uninstall the listed components.

4. To abort, click the Cancel button. If you wish to continue with the uninstall click OK. PKZIP for 
Windows will be removed from your system.

 



Selecting a Directory
This box displays the current directory.    To change directories, double click on the folders.



Selecting a Drive 
This box displays the current drive. To select a new drive, click on the down arrow, then click on the new 
drive.



OK Button
This button saves the dialog and continues with the current process.



Cancel Button
This button stops the current process.



Help Button
This button displays help on the current dialog box.



Network Button
This button allows you to connect to a network location, assigning it a new drive letter. 



List of Files in the Current Directory
This box displays the files in the current directory.    You can select these files to be compressed.



Filter 
This box allows you to type filters (file patterns), for example, *.TXT or *.DOC. To type multiple filters, 
separate each filter with a semicolon (;).Filter will only take files of that particular type.    The filter can be 
selected from the list of the most recently used filters.    The filter information will remain the same when 
moving from directory to directory.    When the filter is selected, only the files that fit the filter will be 
compressed.



Files & Directories to ZIP
This box contains the files and directories you have selected to compress. You can edit this list by using 
the buttons that appear on the lower right part of the Add Files dialog.



Add Files Button
This button adds the files that are currently selected to the Files & Directories to ZIP box.



Add Directory Button
This button adds all of the files from the current directory to the Files & Directories to ZIP box.



Add Filter Button
This button adds all of the files that match the current filter (for example, *.TXT) to the Files & Directories 
to ZIP box.



Add List File Button
This button adds the contents of a LIST File to the Files & Directories to ZIP box.



Exclude Filter Button
This button excludes all of the files for compression that match the filter. For example, to exclude all files 
that end in .TXT, you would select the *.TXT filter, then click on the Exclude Filter button.



Manual Add Button
This button allows you to type files or file patterns to be compressed (instead of selecting them from a 
list).



Add Options Area
This area allows you to compress new files (Add files), update existing files in the .ZIP file (Update files) 
or add “and” update files (Add & Update files). You can also move files from your hard drive to the .ZIP 
file, and assign a password to your ZIP file.



Toggle Include/Exclude Button
This button toggles between including and excluding files in the Files & Directories to ZIP box.



Remove Button
This button removes the files that are selected in the Files & Directories to ZIP box. You must select at 
least one file from the Files & Directories box to use this button.



Remove All Button
This button removes all of the files from the Files & Directories to ZIP box.



Preferences Button
This button displays the Compress Preferences dialog, which allows you to change preferences for 
compressing files. For example, you can select a compression method and store directory path 
information.



Compression Area
This area allows you to select a compression method. Super fast is the fastest method that has lower 
compression. The Fast method is a little faster with better compression. Normal offers the    best balance 
of compression and speed. Extra offers the most compression but at a slower speed. Storing performs no
compression. It just stores the files in the .ZIP file in their normal size.



.ZIP File Date Area
This area allows you to set the date of the .ZIP file.    Select from Today’s date, date of the Newest file, the
date of the Oldest compressed file, or to Retain .ZIP date.



Path Information Area
This area allows you to store path information in the .ZIP file. No path information does not include any 
path information in the .ZIP file.    Relative path stores path information for recursed subdirectories only.    
Full path stores the entire path information for all files compressed.



Attributes Area
This area allows you to compress files with the selected attributes.    When the Retain attributes box is 
checked, the files will retain their attributes after compression. (PKZIP for Windows normally skips files 
that contain these attributes.)



Miscellaneous Area
This area allows you to include subdirectories (recurse), and to store volume labels.



Preference OK Button
This button sets the preference(s) for the current session only. It does not save the preferences for the 
next time you run PKZIP for Windows.



Save as Default Button
This button saves the preferences for the current session “and “all subsequent sessions, until you make 
changes and click on this button again. The next time you run PKZIP for Windows, these preferences will 
take affect.



Extract Files Selection Area
This area indicates whether you are extracting all files or selected files.



Extract Statistics Area
This area displays the number of files and total bytes to be extracted, and is informational only.



Extract to Area
This area allows you to select whether you want to extract to disk or printer. If you extract the files to disk, 
you can select the directory into which you want to extract the files (using the Browse button).



Password Area
This area allows you to enter a password, if required. If a .ZIP file contains a password, you must enter 
that password before you can extract files.



Extracted/Tested File List
This area shows the files to extract or test, and if any warnings occurred.



Extract Options Area
This area allows you to set the extraction options when uncompressing files.    The Overwrite option will 
overwrite files without prompting. Select Update to only extracts newer files that already exist in the 
directory. Select Update and new to extract newer files and files that previously do not exist.    Select 
Prompt user    to have PKZIP for Windows prompt you when it encounters an overwrite situation.



Restore Attributes Area
This area allows you to restore the selected file attributes while extracting.



Extraction Options Area
This area allows you to create directories and store volume labels. The Creating directories option will 
recreate any directory information stored in the .ZIP file. The Restore volume label option restores the 
volume label, if stored.



Temporary Extract Directory Area
This area allows you to set the temporary directory that is used when a compressed file is viewed.



Extract Preference Button
This button displays the Extract Preferences dialog, which allows you to set preferences for extracting 
files.



Extract Button
This button starts the extraction.



Archive Attribute Area
This area allows you to compress only files that have had their archive bit set. If you check the ZIP if 
archive bit set box, only the files with the archive attribute set will be compressed.    If you check the Clear 
archive bit box, the archive attribute will be cleared after the file is compressed.



Directories Button
This button allows you to specify default directories for when you add files to be compressed or for when 
you open .ZIP files. You may also select a temporary directory for compression.
 



What is a Self-Extracting File?

A self-extracting file is a type of ZIP file that you can extract from without actually using PKZIP for 
Windows. In fact, you don’t even need PKZIP for Windows installed on your computer. This self-extracting
file contains “unzipping” instructions directly in the .EXE file. All self-extracting files end in .EXE.

With PKZIP for Windows, you may create the following types of .EXE files:

PKSFX DOSFULL DOS based self-extractor. (Included in the Shareware, Registered, and 
Distribution Licensed versions of PKZIP).

PKSFX JRDOS A smaller, more compact version of the DOS self-extractor. This file 
contains less extraction options than the regular DOS self-extractor, and 
requires less memory to run. (Included in the Shareware, Registered, 
and Distribution Licensed versions of PKZIP).

PKSFX WIN16 16-bit "Windows" self-extractor that works with versions of Windows 
starting with 3.1 and later. This includes long file name support under 
Windows95. (Included in the Shareware, Registered, and Distribution 
Licensed versions of PKZIP).

PKSFX WIN32... 32-bit "Windows" self-extractor that works with versions of Windows95 
and NT (Intel, DEC Alpha, Power PC). This includes long file name 
support under Windows95 and Windows NT. (Available in the Registered
and Distribution Licensed versions of PKZIP).

PKSFX OS/2... OS/2 self-extractor that works with the OS/2 Operating System. (e.g. 
OS/2 Warp version 4). This self-extractor is included in the PKSFXS.DAT
file described here. (Available in the Distribution Licensed version of 
PKZIP).

PKSFX SOL2X... UNIX self-extractors that work with several different flavors of UNIX. (e.g.
Sun Solaris 2.x SPARC). These self-extractors are included in the 
PKSFXS.DAT file described here. (Available in the Distribution Licensed 
version of PKZIP).

You select the type of .EXE file when you create the file.



Creating a Regular DOS Self-Extractor

To create a “regular” self-extracting file:

1. Double-click your mouse on the PKZIPW icon. The PKZIP for Windows main application screen 
appears.

2. From the Menu bar, select File. The File menu appears.

3. Select New. The Save As dialog box appears.

4. In the Save As dialog box, do the following:

· In the File name field, type a name for your self-extracting file. You do not have to type an 
extension.

· Specify a destination directory for your self-extracting file, if different than the current 
directory.

· In the Save as type field, select the following file type:

PKSFX DOSFULL File (*.EXE)

5. To continue, click Save/OK. The Add Files dialog box appears.

6. Select files to add to your .EXE file. When you have finished adding files, click OK in the Add Files 
dialog box. 

PKZIP for Windows begins to compress the selected files into your self-extracting file. The first line 
displays the percentage completed for the entire .EXE file.    The second line displays the percent 
completed for the current file that is being compressed.    The lower area shows how each file was 
compressed and the overall percentage that it was compressed.

7. After all the files are compressed, select the OK button to remove the Add Status dialog box.    PKZIP 
for Windows displays the contents of the file.



Creating a Junior Self-Extractor

To create a “junior” self-extracting file:

1. Double-click your mouse on the PKZIPW icon. The PKZIP for Windows main application screen 
appears.

2. From the Menu bar, select File. The File menu appears.

3. Select New. The Save As dialog box appears.

4. In the Save As dialog box, do the following:

· In the File name box, type a name for your self-extracting file. You do not have to type an 
extension.

· Specify a destination directory for your self-extracting file, if different than the current 
directory.

· In the Save as type field, select the following file type:

PKSFX JRDOS File (*.EXE)

5. To continue, click Save/OK. The Add Files dialog box appears.

6. Select files to add to your .EXE file. When you have finished adding files, click OK in the Add Files 
dialog box. 

PKZIP for Windows begins to compress the selected files into your self-extracting file. The first line 
displays the percentage completed for the entire .EXE file.    The second line displays the percent 
completed for the current file that is being compressed.    The lower area shows how each file was 
compressed and the overall percentage that it was compressed.

7. After all the files are compressed, select the OK button to remove the Add Status dialog box.    PKZIP 
for Windows displays the contents of the file.

Note: Long File Names are not supported with Junior DOS self-extractors. Regular DOS and Windows 
based Self-Extractors will archive files with Long File Names.



Creating a Windows Self-Extractor

To create a Windows self-extracting file:

1. Double-click your mouse on the PKZIPW icon. The PKZIP for Windows main application screen 
appears.

2. From the Menu bar, select File. The File menu appears.

3. Select New. The Save As dialog box appears.

4. In the Save As dialog box, do the following:

· In the File name box, type a name for your self-extracting file. You do not have to type an 
extension.

· Specify a destination directory for your self-extracting file, if different than the current 
directory.

· In the Save as type field, select one of the following:

PKSFX WIN16 File (*.EXE) for a 16-bit Windows based self-extractor

or

PKSFX WIN_X86_G260 File (*.EXE) for a 32-bit Windows based self-extractor

5. To continue, click Save/OK. The Add Files dialog box appears.

6. Select files to add to your .EXE file. When you have finished adding files, click OK in the Add Files 
dialog box. 

7. The PKSFX for Windows - Options dialog appears. Specify appropriate options  for your self-
extracting file, if necessary.

8. When you have finished specifying options, click OK in the PKSFX for Windows - Options dialog box. 

PKZIP for Windows begins to compress the selected files into your self-extracting file. The first line 
displays the percentage completed for the entire .EXE file.    The second line displays the percent 
completed for the current file that is being compressed.    The lower area shows how each file was 
compressed and the overall percentage that it was compressed.

9. After all the files are compressed, click OK button to remove the Add Status dialog box.    PKZIP for 
Windows displays the contents of the file.



Creating Self-Extractors With the pksfxs.dat File
The Distribution Licensed version of PKZIP includes an external data file called pksfxs.dat. It is only 
available and will only function with the Distribution Licensed version of PKZIP. The pksfxs.dat file allows 
users to create self-extractors (in addition to the extractors included with the Shareware and Registered 
versions of PKZIP) for several different platforms. The Save As dialog will list the available self-extractors,
including those contained in the pksfxs.dat file. 

If you plan to place the pksfxs.dat file in a directory other than the installation directory, you must set an 
environment variable (SET PKSFXDATA=<path to the pksfxs.dat file>) for the file. On Windows 
3.1x/95/NT 3.51 systems, this variable is set in the autoexec.bat file. On Windows NT 4.0 systems, this 
variable is set through the control panel.

To create a self-extracting file from the pksfxs.dat file:

1. Double-click your mouse on the PKZIPW icon. The PKZIP for Windows main application screen 
appears.

2. From the Menu bar, select File. The File menu appears.

3. Select New. The Save As dialog box appears.

4. In the Save As dialog box, do the following:

· In the File name box, type a name for your self-extracting file. You do not have to type an 
extension.

· Specify a destination directory for your self-extracting file, if different than the current 
directory.

· In the Save as type field, select the type of self-extractor you wish to create. If, for example, 
you wish to create an OS/2 based self-extractor select the following:

PKSFX OS2_X86_C260 File (*.EXE)

5. To save your changes, click Save/OK. The Add Files dialog box appears.

6. Select files to add to your .EXE file. When you have finished adding files, click OK in the Add Files 
dialog box. 

7. Sice you selected a Windows based self-extractor in step 4, the PKSFX for Windows - Options dialog 
appears. Specify appropriate options  for your self-extracting file, if necessary.

8. When you have finished specifying options, click OK in the PKSFX for Windows - Options dialog box. 

PKZIP for Windows begins to compress the selected files into your self-extracting file. The first line 
displays the percentage completed for the entire .EXE file.    The second line displays the percent 
completed for the current file that is being compressed.    The lower area shows how each file was 
compressed and the overall percentage that it was compressed.

9. After all the files are compressed, click OK button to remove the Add Status dialog box.    PKZIP for 
Windows displays the contents of the file.

Note: PKWARE will periodically update the pksfxs.dat file as self-extractors are developed for other 
operating systems and platforms. As updates are created, they will be made available to Distribution 
Licensed users of PKZIP who have purchased the subscription option. Contact PKWARE for further 
information.



Setting PKSFX Options
The following is a description of each item of the PKZIP for Windows - Options dialog. Please note that 
some of these options are only available in the Registered and/or Distribution Licensed versions of PKZIP
for Windows.

Title bar name    

When files are extracted from a Windows self-extractor, a PKSFX extraction dialog appears that allows
the user to specify additional extraction options. If you wish to specify a text string in the title bar of the 
PKSFX extraction dialog, type it in this box. The title bar is the top portion that identifies a particular 
dialog box. This feature is only available in the Distribution Licensed version of PKZIP for Windows.

Extract To 

Type the destination directory for the files archived in the self-extractor. If you do not specify a drive 
letter (e.g. "C"), PKZIP will use the drive on which your temporary directory is located. If the directory 
(or directory path) you specify does not exist, PKZIP will ask you if you wish to create it.

The path specified in the Extract To box will appear in the corresponding Extract To box when the self-
extractor is run. This dialog appears when you double-click on the self-extractor icon to begin 
extraction.

Run after extraction

If you wish to automatically run an executable file after files are extracted from a self-extractor, specify 
a full path to that executable file here. If you are unsure of the location of the file, use the Browse 
button. This feature is only available in the Distribution Licensed version of PKZIP for Windows.

Recreate subdirectories

If you wish to recreate subdirectories stored with the files archived in the self-extractor on extraction, 
click this check box.

Note: When you compress files into a standard or self-extracting .ZIP archive, PKZIP allows you to store 
directory path information in addition to the files. You then have either the option of extracting the files 
alone or with their corresponding paths.

Display Messages

When you extract files from a self-extractor, PKZIP may display warning messages in the display area 
located at the bottom of the Extract dialog. Depending on your computer, these messages might flash 
on and off your screen before you can read them. If you wish to display each warning message in a 
separate message box, click this check box.

Note: The Display Messages check box applies only to warning messages. It does not apply to error 
messages.

Overwrite

This area allows you to specify how overwrite operations should be handled by PKZIP. A lisitng of the 
available overwrite options follows:

Prompt - Prompt you every time PKZIP encounters a file name in the destination/extraction directory 
that matches the name of the file being extracted.



Always - Always overwrite those files that exist in the destination/extraction directory regardless of    
matching file names (PKZIP will not prompt you).

Never - Never overwrite those files that exist in the destination/extraction directory regardless of    
matching file names (PKZIP will not prompt you)

Create program group

PKZIP allows you to create a program group for files stored in your self-extracting .ZIP archive. You 
also have the option of creating icons for the those files. This feature is only available in the 
Registered and Distribution Licensed versions of PKZIP for Windows.

What is a program group?

Creating a program group involves actual group creation followed by the creation of the individual 
items that will displayed in the group. Each item represents a program or application that you want 
grouped with other programs and applications.

The Create program group area contains two components:

· The check box, which enables you to “create” program groups.

If you check this box, the corresponding box in the PKSFX dialog box (the box that appears 
first when the files from this self-extractor are extracted) will also be checked.

· The Edit button, which enables you to “enter” program groups.

To create a program group:

1. Click the Edit button that appears to the right of Create 
program group. The Create Program Group dialog box appears.

2. In the Group Name item, type a name for your program group. This name will appear as the title 
for the program group.

3. To add group items, click on Add. The Group Item dialog box appears.

4. Make the appropriate entries for the following items:

Caption

Type a caption for this group item. This will appear directly below the icon for this item. If you
do not type a caption name, Windows uses the name of the program from the Command line
text box.

Command line

Select the name of the program to be associated with this group item. Use the Browse 
button to locate that program.

When you click on a file using Browse, the full path of that file appears in the box. You 
should probably change all full paths to relative paths because the user (the person 
extracting from this self-extractor) can change the Extract To box in the PKSFX dialog box. 
All relative paths are relative to the path in the Extract To box of the PKZIP for Windows - 
Options dialog box.

Icon

To select an icon for your self-extractor:



· In the first box, type the location and name of the file that contains the icon.

· In the second (smaller) box, type the number that corresponds with the existing icon 
you want to use. The first icon in the file is 0 (zero), the second is 1, and so on. 

In Windows 3.1x/NT 3.51, you can locate an icon by clicking your mouse on the group 
item, selecting File | Properties from the Menu bar, and clicking on the Change Icon 
button.

In Windows 95/NT 4.0, you can locate an icon by clicking your right mouse button on the 
program group icon, clicking the left mouse button on the Shortcut button, selecting 
Properties, then clicking the left mouse button on the Change Icon button.

5. When you have finished creating group items, click OK in the Group Item dialog box. The group 
item(s) are entered and the Create Program Group dialog box appears.

6. To create a group that you just entered, click in the check box that appears to the left of Create 
program group in the PKSFX for Windows - Options dialog box.

To: Click on:
Add a program group Adding Program Groups

Edit an existing program group Editing Program Groups

Delete a program group Deleting Program Group Items

Register extensions

To register file extensions for this self-extractor:

Why register file extensions?

PKZIP for Windows allows you to register extensions for selected files contained in a self-extracting .ZIP 
archive. If, for example, a file exists in your self-extracting .ZIP archive with a .htm extension, you have 
the option of selecting the application with which you wish to associate files with the .htm extension. The 
selected application would then open by default when the .htm file is executed via File Manager or 
Explorer.    Keep in mind that once PKZIP completes such an operation, all files with a particular extension
will be associated with a particular application. This feature is only available in the Registered and 
Distribution Licensed versions of PKZIP for Windows.

To: Click on:
Register an extension Registering New File Extensions

Edit an existing extension registry Editing Registered Extensions

Delete a registered extension Deleting Registered Extensions



Adding Program Groups

To add a program group to your self-extractor:

1. Click on the Edit button that appears to the right of Create program group. The Create Program 
Group dialog box appears.

2. In the Group Name field, type a name for your program group.

3. To add group items, click on the Add button. The Group Item dialog box appears.

4. Make the appropriate entries in the following fields:

Caption 

Type a caption for this group item. If you do not type a caption name, PKZIP for Windows uses the 
name of the program from the Command line area.

Command line 

Select the name of the program that is to be executed for this group item. This is a required field. If 
the Caption area is left blank, this name will be used as the caption for the group item icon.

Icon 

To select an icon for this group item, do one of the following:

· In the first box, type the executable file associated with the icon you want to use, or type the 
file name associated with that icon.

· In the second (smaller) box, type the number that corresponds with an existing icon you want 
to use. The first icon in a program group is 0 (zero), the second is 1, and so on.

In Windows 3.11, you can locate an existing icon by clicking on the program group, 
selecting File | Properties from the Menu bar, and clicking on the Change Icon button. 

In Windows95, you can locate an existing icon by right clicking on the program group 
icon, clicking on the Shortcut button, and clicking on the Change Icon button.

5. Click OK in the Group Item dialog box. The group item is created and the Create program group 
dialog box appears. 

To create more group items, repeat steps 3 through 5.



Editing Program Groups

To edit a program group for a self-extractor:

1. In the PKSFX for Windows -Options dialog box, click on the Edit button that appears to the right of the
Create program group field. The Create program group dialog box appears.

2. Click on Edit. The Group Item dialog box appears. 

3. Edit the appropriate fields in this dialog box. 

4. When you have finished with this dialog box, click OK. The program groups are changed and the 
Create program group dialog box reappears.



Deleting Program Group Items

To delete a program group item from a self-extractor:

1. In the PKSFX for Windows - Options dialog box, click on the Edit button that appears to the right of 
the Create program group field. The Create program group dialog box appears.

2. Click on the program group item that you want to delete.

3. Click on Delete. The program group item is deleted from this self-extractor. The Group Item dialog 
box reappears.



The Group Item Dialog Box

Caption 

Type a caption for this group item. If you do not type a caption name, PKZIP for Windows uses the name 
of the program from the Command line area.

Command line
Select the name of the program that is to be executed for this group item. This is a required field. If the 
Caption area is left blank, this name will be used as the caption for the group item icon.

Icon 

To select an icon for this group item, do one of the following:

· In the first box, type the executable associated with the icon you want to use, or type the file 
name associated with that icon.

· In the second (smaller) box, type the number that corresponds with an existing icon you want 
to use. The first icon in a program group is 0 (zero), the second is 1, and so on.

In Windows 3.1x/NT 3.51, you can locate an existing icon by clicking on the program group, selecting File
| Properties from the Menu bar, and clicking on the Change Icon button. 

In Windows 95/NT 4.0, you can locate an existing icon by right clicking on the program group icon, 
clicking on the Shortcut button, and clicking on the Change Icon button.



What is a Program Group?

A program group is a collection of one or more programs associated with a software application. For 
example, if you are distributing multiple programs with your self-extractor, you can group each program 
(referred to in PKZIP for Windows as a “group item”) into one program group. You can even have your 
self-extractor create “icons” for each group item.



Why Register File Extensions?

If you are distributing a program with your self-extractor that contains a file extension that the user of the 
self-extractor might not have registered on their system, you can have your self-extractor register it for 
them. So when the user extracts from your self-extractor, he or she can choose whether or not to 
automatically register extensions.    



Registering New File Extensions

To register file extensions:

1. In the PKSFX for Windows - Options dialog box, click on the Edit button that appears to the right of 
Register extension(s). The Register Extension(s) dialog box appears.

2. Click on the Add button. The Association dialog box appears.

3. Make the appropriate entries for the following items:

Program name

Type the name of the program for which you want to register extensions (for example, 
“widgets.exe”).

Extension

Type the three-character extension “without” the period (for example, EXE).

4. When you have finished completing these items, click OK in the Association dialog box. The 
extension is entered and the Register Extension(s) dialog box reappears.

5. To register extensions that you just entered, click in the check box that appears to the left of Register 
extension(s) in the PKSFX for Windows - Options dialog box.

Save as Default Button
Click on this button to save all the values in this dialog box as defaults. You can use these defaults 
another time using the Load Default button.

Load Default Button
Click on this button to load the default values for this dialog box. To have a default value, you must 
have clicked on Save as Default at least once.

Load Current Button
Click on this button to load the values from the current self-extractor. This applies only to existing self-
extractors that already have values associated with these options. If you are creating a new self-
extractor, this button will be disabled.

Clear Button
Click on this button to clear (erase) the current values in this dialog box.



Editing Registered Extensions

To edit registered extensions:

1. In the PKSFX for Windows - Options dialog box, click on the Edit button that appears to the right of 
the Register extension(s) field. The Register extension(s) dialog box appears.

2. Click on an extension in the white box.

3. Click on Edit. The Association dialog box appears.

4. Edit the appropriate fields in this dialog box.

5. When you have finished with this dialog box, click OK. The program groups are changed and the 
Create program group dialog box reappears.



Deleting Registered Extensions

To delete a program group from a self-extractor:

1. In the PKSFX for Windows - Options dialog box, click on the Edit button that appears the right of the 
Register extension(s) field. The Register extension(s) dialog box appears.

2. Click on the file extension that you want to delete.

3. Click on Delete. The file extension registry is deleted from this self-extractor. The Register 
extension(s) dialog box reappears.



The Association Dialog Box

Program name

Type the name of the program for which you want to register extensions.

Extension

Type the three-character extension “without” the period.



The Register Extension(s) Dialog Box
Extensions
This area contains extensions that you have registered.

Add button
Click on this button to add registered extensions.

Edit button
Click on this button to edit registered extensions.

Delete button
Click on this button to delete registered extensions.

 



Adding Files With a List File
Rather than manually adding individual files to a .ZIP archive, you have the option of using a List file in 
PKZIP for Windows. A List file is an ASCII text file that contains file names and their locations. A List file 
can be an ideal solution for users who archive specific file sets on a regular basis. It saves time in that it is
not necessary to specify appropriate file names and paths each time you wish to compress these files 
with PKZIP for Windows. A List file may contain wild card specifications (*,?) as well as exact file names 
and paths. 

A List file might look similar to the following:

c:\*.exe
z:\*.doc
\tut\*.doc
\tut\?????.*
pkware.txt

When you do not specify a disk drive (e.g. c:) in a list file item, PKZIP will assume that you wish to add the
current working drive into your Files & Directories To Zip designation. Similarly, if you do not specify a 
directory path in a list file item, PKZIP will assume that you wish to add the current working directory into 
your Files & Directories To Zip designation. As you can see, the format follows standard DOS/Windows 
path and wildcard conventions. You may create and/or modify your List file with any standard ASCII text 
editor. (e.g. Notepad) Save the file with an easy to remember filename (e.g. listfile.txt), in a directory 
where you can locate it easily later.

To use a List file:

1. Start PKZIP for Windows by double clicking on the icon. The PKZIP for Windows main application 
screen appears.

2. Open an existing .ZIP archive and select Compress | Add Files from the menu bar or create a 
new .ZIP archive by selecting File | New from the menu bar. Specify a name and location for your 
new .ZIP archive. The Add Files dialog box appears.

3. Locate the List file you created and highlight it by clicking on it once.

4. Click the Add List File button. The contents of your List file will appear in the Files & Directories to 
Zip box.

5. When you are finished click OK. Any files that you specified in the Add Files dialog, including those in 
you List file are added to the .ZIP archive.

 



File Format Support
PKZIP for Windows allows you to extract files from encoded or Tar & GZIP archived data. PKZIP will 
decode and extract files created with the following encoding and archive schemes:

Encoded File Type Common File Extensions

UUEncode *.UUE

XXEncode *.XXE

BinHex *.HQX

MIME *.MIM *.MME

Tar *.TAR

GZIP *.GZ *.TGZ

Extracting Files From an Encoded File

To open and extract files from an encoded file:

1. Start PKZIP for Windows by double clicking on the icon. The PKZIP for Windows main application 
window appears.

2. From the Menu bar, select File | Open. The Open dialog box appears.

3. In the Files of type box, select the file type you wish to open. For example, Encoded Files (*.UUE; 
*.XXE; *.MIM; *.MME; *.HQX) or Tar & Gzip (*.TAR; *.TGZ; *.GZ). Those files that match the selected 
file pattern(s) will appear in the Open dialog box.

4. Double-click the file that you wish to open or simply type the path and/or name of the file in the File 
name box and click the Open button. PKZIP for Windows displays the contents of the file in the main 
application window.

5. Select the files you wish to extract.

6. From the Menu bar, select Extract | Extract files. The Extract dialog appears

7. Select a destination for the files to be extracted. Type a location - such as a drive or directory path - or
use the Browse button to search for a location.

8. Set Preferences, if needed, by clicking on the Preferences button and clicking on the appropriate 
radio buttons and checkboxes. 

9. When you have finished selecting a destination, click on Extract to start extracting.    PKZIP for 
Windows displays the Extract box.

10. As PKZIP for Windows extracts the files, it displays the current status of the    extraction process in 
the Progress area of the dialog box. The name of the current file being extracted appears next to the 
word Filename.    The percent completion changes as it extracts. As each file is extracted, an OK 
appears next to that file. At the bottom of the dialog box, PKZIP for Windows displays the number of 



warnings.

11. When the last file is extracted, PKZIP for Windows displays a “Done” message. When you see this 
message, click on the Done button to exit.

Converting .ZIP Files to UUEncoded Format

PKZIP for Windows allows you to convert .ZIP files (standard and self-extracting) to the UUEncoded 
format. This converts .ZIP files from binary format to ASCII format allowing you to send such files safely 
via email.

To convert files to UUEncoded format:

1. Open or create the .ZIP file that you wish to UUEncode. The file will be displayed in the PKZIP for 
Windows main application window.

2. From the menu bar select File | UUEncode .ZIP file. 

3. PKZIP will UUEncode the file and place it in the same directory as the source (original) .ZIP file. It will 
have the same name as the source .ZIP file however PKZIP will replace the .ZIP or .EXE extension 
with a .UUE extension. (e.g. filename.zip --> filename.uue)

 




